
หน่วยการเรียนทีÉ 4 
การสร้างเวบ็เพจด้วยโปรแกรม Dreamweaver  

 
สาระการเรียนรู้ 
 การสร้างเวบ็เพจในปัจจุบนั เราจะเห็นวาหน้าเวบ็เพจมีความสวยงาม  มีเทคนิคตาง ๆ มากมาย   ่ ่
แตละเวบ็ไซตก์จะมี่ ็ รูปแบบท่ีผูอ้อกแบบพยายามสร้างสรรคด์ว้ยโปรแกรมกราฟิกมากกวา  ่ 2 โปรแกรม
ขึน้ ไป  ซ่ึงหมายถึงเบืองหลงัการจดัทาํเวบ็นนั  นกัออกแบบตอ้้ ้ งมีความรู้ทงัโปรแกรมสร้างเวบ็ ้ โปรแกรม
สร้างงานกราฟิก  ตาง ๆ   ่  
 ดา้นโปรแกรมสร้างเวบ็นนั  การท่ี้ เราตอ้งสร้างเวบ็เพจในเวบ็ไซตห์น่ึง ๆ จาํนวนมาก  การเขียน
ดว้ยโปรแกรมภาษาเพียงอยางเดียวอาจไมเพียงพอ่ ่  เพราะการใสเทคนิค  สร้างความนาสนใจตาง ๆ จะตอ้ง่ ่ ่
ใชค้าํสังภาษา ่ HTML จาํนวนหลายสิบบรรทดั นกัสร้างเวบ็ระดบัมืออาชีพจึงหนัมาใชโ้ปรแกรมสาํเร็จรูป
รวมกบโปรแกรมภาษา ซ่ึงเป็นวิธีท่ีทาํงานไดเ้ร็วเพราะโปรแกรมเหลานนัสร้างคาํสัง่ ั ่ ้ ่  HTML หรือ XML
ใหท้าํใหป้ระหยดัเวลาและไดง้านมีคุณภาพ    
 การจดัเนือหา้ วิชาการสร้างเวบ็ในเอกสารน้ี จึงจดัใหน้กัศึกษาเรียนรู้โปรแกรมภาษา  HTML  แลว้
ตามดว้ยโปรแกรมสาํเร็จรูป  โดยใชโ้ปรแกรม  Dream weaver 8  ซ่ึงถือไดว้าเป็นโปรแกรมสาํเร็จรูป่         
ท่ีนิยมใช้กนั มากให้เทคนิคพืนฐานได้ดี   ไมต้องใช้หนวยความจํา้ ่ ่ (RAM) มาก   เหมาะกบเคร่ืองั
คอมพิวเตอร์ในสถานศึกษา  ซ่ึงไมสามารถปรับเปล่ียนรุนไดง้านนัก    ่ ่ ่ เนือท่ีจดัไว้้ แบงตาม่ เง่ือนไขเวลา
เรียนท่ีหลกัสูตรกาหนดํ   โดยหนวยการเรียนท่ี   ่ 4    นีจะกลาวถึงการ้ ่ เตรียมโปรแกรมเพื่อใชง้าน   การตงั้
คา่ เริมตน้่ ให้รองรับภาษาไทย  รู้จกัเคร่ืองมือของโปรแกรม    แลว้ทาํการฝึกสร้างเวบ็ดว้ยการใชต้าราง      
จดัระเบียบเนือหา  ซ่ึงถือเป็นหนวยเริมตน้้ ่ ่  เตรียมใหส้ามารถใชง้านโปรแกรมและลงเนือหา้ ได ้ตอไป่   

 ผงัความคดิ (Mind Mapping) 
 
 

2.ลกัษณะและความสาํคญัของโปรแกรม 

การสร้างเวบ็ด้วยโปรแกรม Dreamweaver8.0  

1.ประวติัการพฒันาโปรแกรม 

6.การกาหนด ํ Folder และ Site เกบ็งาน 

5.รู้จกัเคร่ืองมือของโปรแกรม 

3.การติดตงัโปรแกรม้  

4.การกาหนดคาเริมตน้กอนใช ้ํ ่ ่ ่
โป

7.การสร้างเวบ็เพจดว้ย Dreamweaver 
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จดปุ ระสงค์การเรียนรู้ 
                1. บอกลกัษณะความสาํคญัโปรแกรม Dreamweaver8.0 ได ้
                2. บอกประวติัการพฒันาโปรแกรม Dreamweaver8.0 ได ้
                3. ติดตงัโปรแกรม้ Dreamweaver8.0 ได ้
                4.  สามารถกาหนดคาเริมตน้กอนใชง้านโปรแกรํ ่ ่ ่ มDreamweaver 8.0
                5. ใชเ้คร่ืองมือของโปรแกรม Dreamweaver 8.0 ได ้
                6.  สร้างโฟลเ์ดอร์ และ ไซต ์เกบขอ้มูลสร้างเวบ็ไซตไ์ด้็  
                7.  ปฏิบติัการออกแบบเวบ็ดว้ยเทคนิคการใชต้ารางจดัขอ้มลูได ้
                8.  สามารถทาํงานรวมกบเพื่อน  มีคุณธรรมจริยธรรม  รักษาระเบียบวนิยัไดดี้่ ั  

 ได ้ 
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การสร้างเวบ็เพจด้วยโปรแกรม Dreamweaver 8.0 
 

 การสร้างเวบ็ ตอ้งสามารถสร้างงานไดเ้ร็ว  มีเทคนิคสร้างความนาสนใจทาํให้ผูช้มติดตามได้่
อยางเหมาะสม  ในขณะสร้างตอ้งสามารถแกปัญหาคาํสัง ่ ้ ่ HTML ได ้ดงัไดจ้ดัเนือหาภาษา้  HTML ไวใ้น
หนวยการเรียนท่ี ่ 3 แล้ว ตังแ้ ตหนวยการเรียนท่ี่ ่  4 เป็นต้นไปนักเรียนจะเรียนรู้การใช้โปรแกรม 
Dreamweaver 8.0 สร้างเวบ็ไซต ์  เพื่อใหไ้ดเ้รียนรู้และสร้างผลงานไดร้วดเร็ว ดงัหวัขอ้ตอไปนี่ ้  

 
   1.     ประวตักิารพฒันาโปรแกรม Dreamweaver 

 
                อะโดบี ดรีมวีฟเวอร์  (Adobe Dreamweaver) ช่ือเดิมคือแมโครมีเดีย ดรีมวีฟเวอร์ (Macromedia 
Dreamweaver) พฒันาโดยบริษทัแมโครมีเดีย       ปัจจุบนัควบกจิ การรวมกบับริษัท อะโดบีซิสเต็มส์         
คนสวนใหญเรียกช่ื่ ่ อสนัสนัวา ้ ้ ่ “โปรแกรมดรีมวีฟเวอร์”โปรแกรม Dreamweaver  เป็นโปรแกรมออกแบบ
เวบ็ไซตใ์นรูปแบบ WYSIWYG  กบการควบคุมของสวนแกไขรหสั ั ่ ้  HTML  การพฒันาโปรแกรมที่มีการ
รวมทงัสองแบบเขา้ดว้ยกนแบบนี ้ ั ้  ทาํใหเ้ป็นผูอ้อกแบบสามารถออกแบบงานในมุมมองเหมือนจริงอยางท่ี่
ตอ้งการไปพร้อม ๆ กบ การมองเห็นั รหัสภาษา HTML  ผูอ้อกแบบท่ีมีพืนความรู้ภาษา ้ HTML บา้งจึง
สามารถออกแบบงาน แกไขคาํสงั้ ่ ท่ีตอ้งปรับแกไข้ ความกระชบั หรือตดัสวน่ ท่ีโปรแกรมสร้างมา แตไมได้่ ่
ใชอ้อกได ้เพื่อใหแ้สดงผลไดต้รงความตอ้งการมากท่ีสุด จึงทาํให้เป็นโปรแกรมท่ีไดรั้บความนิยมใชม้าก  
ปี พ.ศ. 2544   ดรีมวีฟเวอร์ มีสัดสวนตลาด่ การใชโ้ปรแกรมประเภทสาํเร็จรูปมากกวา่ 70%  ประวติัการ
พฒันาโปรแกรมเวอร์ชนัตางๆ่  ของ Dreamweaver  มีดงัน้ี 
 
 Dreamweaver 1.0 (ธ.ค.1997)  Dreamweaver 1.2 (มี.ค.1998) 

Dreamweaver 2.0 (ธ.ค.1998)  Dreamweaver 3.0 (ธ.ค.1999) 
Dreamweaver UltraDev 1.0 (มิ.ย.2000)  Dreamweaver 4.0 (ธ.ค.2000) 
Dreamweaver UltraDev 4.0 (ธ.ค.2000) Dreamweaver MX (พ.ค.2002) 
Dreamweaver MX 2004 (พ.ย.2003)  Dreamweaver 8 หรือ CS2  (พ.ย. ค.ศ.2005) 
Dreamweaver 9  หรือ  CS3  (มี.ค.2007)   Dreamweaver 10 หรือ CS4 ( ต.ค. 2008) 
  

ทีม่า: http://www.webthaidd.com/dreamweaver/news.php?id=445 
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   2.     ลกัษณะและความสําคญัของโปรแกรม 
 
 

  โปรแกรม Dream weaver เป็นโปรแกรมออกแบบเวบ็สาํเร็จรูปท่ีรวมการทาํงาน  2 รูปแบบไว้
ในโปรแกรมคือ   รูปแบบ WYSIWYG(What -You – See- Is-What-You-Get ) และ การควบคุมของสวน่
แกไขรหัส ้  HTML  ทาํใหผู้ใ้ชง้านสามารถออกแบบเวบ็เพจไดง้าย ไมตอ้งมีความรู้ดา้นโปรแกรมภาษา่ ่
มากนัก เพราะโปรแกรมจะทาํการสร้างรหัส HTML ให้ทนัทีเม่ือมีการออกแบบในมุมมองออกแบบ          
ตามรูปแบบ  WYSIWYG  คือเราสามารถใสเนือหา  กราฟิกตาง ๆ ลงในหนา้เอกสารเวบ็  พร้อมกบ่ ่ ั้
สามารถดูรูปแบบจริงไดใ้นระหวางการ่ สร้าง หรือแกไข้    หากตอ้งการเพิมเติมหรือแกไขรหัส ่ ้  HTML     
กสามารถทาํได้็ และดูผลไดท้นัที    เน่ืองจากภาษา HTML  เป็นโปรแกรมท่ีไมยดึติดกบโครงสร้างภาษา   ่ ั
ปัญหาการเขียนรหสัคาํสัง่ จึงแทบไมมีเลย  ่  การเรียนรู้การใชง้านโปรแกรม  Dreamweaver หากไดเ้ริม่ ตน้
ดว้ยภาษา HTML เพียงเล็กน้อยเป็นพืนฐาน  รู้คาํสังหลกั ๆ ้ ่ พอสมควร กจะสามารถเรียนรู้การใชง้าน็
โปรแกรม Dreamweaver  ไดง้ายและรวดเร็ว่ ยง่ิขึน้  
 

 ความสามารถของโปรแกรม กบัการใช้งานร่วมกบัโปรแกรมภาษาอืน่ ๆ  
 Dream weaver สามารถทาํงานกบัโปรแกรมภาษาคอมพิวเตอร์ในการเขียนเวบ็ไซตแ์บบ              
ไดนามิค ซ่ึงมีการใช ้HTML เป็นตวัแสดงผลของเอกสาร เชน ่ ASP, ASP.NET, PHP, JSP และ Cold 
Fusion รวมถึงการจดัการฐานขอ้มูลตางๆ ่ และ ยงัสามารถทาํงานรวมกบ ่ ั XML และ CSS ไดอ้ยางงายดาย่ ่  
 
 สรปุ จดเด่นของโปรแกรมุ   Macromedia Dreamweaver 8  
 

1. โปรแกรมจะทาํการแปลงรหัสให้เป็นภาษา HTML โดยอตัโนมติั    ดงันนั้ ผูใ้ชท่ี้ไมมีความรู้ ่
ดา้นนีกสามารถทาํได ้้ ็  

2.  มีแถบเคร่ืองมือ หรือแถบคาํสัง ท่ีใชใ้นการควบคุมการทาํงาน แบงออกเป็นหมวดหมูจึงชวย่ ่ ่ ่
ในการทาํงานท่ีดีขึน และรวดเร็วยงิขึน ้ ้่  

3.  สนบัสนุนเวบ็เพจท่ีเป็นภาษาไทยไดดี้  
4.  มีคุณสมบติัท่ีสามารถจดัการกบรูปภาพเคล่ือนไหว ั ไดโ้ดยไมตอ้งอาศยั่ โปรแกรมเสริม 
5.  สามารถเรียกใชต้ารางจากภายนอก โดยการอิมพอร์ทจาก Text File  
6.  เป็นโปรแกรมท่ีสนบัสนุนการใชง้าน CSS (Cadcading Style Sheet)  
7.  มีความสามารถในการทํา Drop Down Menu  รวมไปถึงการทําให้รูปภาพเปลี่ยน                

เม่ือนําเมาส์ไปชี Ê  
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   3.     การตดิตั้งโปรแกรม Dreamweaver 8.0 

  
   ในท่ีนีจะแสดงการติดตงั  กรณีใชแ้ผนชุด ้ ้ ่ Studio 8 มีขนัตอนดงัรูปท่ี้  4.1 
 1.  ใสแผน่ ่  Dreamweaver 8 ลงในไดร์ฟ CD-ROM ใหค้ลิกเลือกท่ี Dreamweaver 8 > Install   
โปรแกรมจะดาํเนินการขนัตอไป้ ่  
 2. โปรแกรมติดตงัจะเริมทาํงานโดยอตัโนมติั้ ่     หากไมทาํงานใหเ้ลือ่ กคาํสง่ั Start > Run คลิกท่ี
ปุ่ม Browse...  แลว้เลือกไฟล ์Dreamweaver 8 .exe ในแผน่ Dreamweaver 8   จากนนัคลิกท่ีปุ่ม้  OK เพื่อ
เริมติดตงั่ ้  หรือกรณีไมใชแผนชุด่ ่ ่  Studio 8.0 ใหเ้ริมจาก ่ Start > Run…เชนกน่ ั  
 

 

 

 

 

 

 

 

 รูปท่ี 4.1  แสดงหนา้ตางเมนู โปรแกรมชุด ่ Macromedia Studio 8 

  3. โปรแกรมติดตงัจะแสดงขอ้ความเกยวกบลิขสิทธิในการใชง้านใหเ้ขา้ใจแลว้เลือกหวัขอ้้ ี่ ั Í    I 
accept… แลว้คลิกปุ่ม Next ดงัรูปท่ี 4.2 

 

  

 

 
รูปท่ี 4.2  แสดงหนา้ตาง่ ยอมรับลิขสิทธิของÍ โปรแกรม 
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 4. โปรแกรมจะบอกตําแหนง่ ท่ีจะติดตังอยูท่ีไหน้ ่  โดยปกติจะติดตังท่ี้  C:\Program 
Files\Macromedia\Dreamweaver 8    หากตอ้งการเปล่ียนท่ีติดตงัใหเ้ลือก ้ Change… และเลือกตาํแหนงใน่
การติดตงัใหมตามตอ้งการ้ ่  และถา้ตอ้งการใหส้ร้าง Shortcut ไวท่ี้หนา้จอ ใหค้ลิกเลือก Create Shortcut on 
Desktop (for All Users) ดงัรูปท่ี 4.3 

 

รูปท่ี 4.3  แสดงตาํแหนงติดตงั่ ้ โปรแกรม 

 
 
 
 
 
 
 
 
    5. เลือกชนิดของไฟลท่ี์จะใชง้านรวมกบ่ ั  Dreamweaver 8 เลือกตวัท่ีเราตอ้งการ ให้เลือก
ทงัหมด ้ แลว้คลิก Next   ดงัรูปท่ี 4.4 

 

รูปท่ี 4.4  แสดงการเลือกโปรแกรมท่ีสามารถใชร้วมกนได้่ ั  

   

 

 

 

 ขนัท่ี ้ 1-5 นีถือเป็นขนัตอนการเตรียมความพร้อม และเลือกรายการเพื่อให้โปรแกรมเลือก้ ้
รายการติดตงัใหเ้ราเทานนั้ ้่  

   6.โปรแกรมพร้อมทาํการติดตงั้  ใหเ้ลือกปุ่ม Install > โปรแกรมจะกาลงัทาํการติดตงัํ ้  ใหส้ังเกต
ความกาวกาวหนา้ ้ ้ > จนถึง แสดงปุ่ ม   Finish   > คลิกปุ่ม   Finish เป็นอนัวาการลงโปรแกรมเสร็จ สามารถ่
ใชง้านได ้  ดงัรูปท่ี 4.5 
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 รูปท่ี 4.5  แสดงลาํดบัการ Install โปรแกรม 

 

 4.    การกาํหนดค่าเร่ิมต้นก่อนใช้งานโปรแกรม 
  

 เม่ือติดตงัโปรแกรมเสร็จให้ทาํการตงั้ ้ คาเริมตน้เพื่อไมให้เกดปัญหา่ ่ ิ่ การใชง้าน  และเม่ือแสดง
บนโปรแกรมบราวเซอร์   โดยเฉพาะการแสดงภาษาไทย  หรือ  การแสดงขนาดรหัส HTML ในหนา้-
ออกแบบ    การตงัคาเริมตน้ทาํไดด้งันี้ ่ ่ ้  

 เปิดเมนู Edit > Preference เพื่อตงัคาต้ ่ ามตอ้งการ โดยในท่ีนีจะไมกลาวรายละเอียดของแตละ้ ่ ่ ่
รายการ จะกลาวเนน้เฉพาะจุดสาํคญั ดูรูปท่ี ่ 4.6 เปิดหนา้ตาง่  Preference 
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รูปท่ี 4.6  หนา้ตาง ่ Preference ตงัคาเริมตน้กอนใช้้ ่ ่ ่  โปรแกรม 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
จะเห็นสวนประกอบรายการ่ (Category)  มี 19 รายการคือ(เวอร์ชนั CS3  มี 20 รายการ) 
 

สว่นประกอบ คาํอธิบาย 
General ปรับแตงการทาํงานทวัไป่ ่  
Accessibility ปรับแตงการใชง้าน่  Dreamweaver  ใหเ้หมาะกบผูมี้ปัญหาทางดา้นรางกายั ่   
Code Coloring กาหนดสีแทก็ ํ HTML 
Code Format กาหนดรูปแบบการเขียนํ รหสัคาํสัง่  HTML 
Code Hints กาหนดคาท่ีใชบ้อกใบร้หสัเพื่อใหเ้ขียนรหสัคาํสังํ ่ ่ ไดเ้ร็วขึน้  
Code Rewriting กาหนดวธีิจดัการํ รหสัคาํสัง่  HTML อตัโนมติั 
Copy/Paste กาหนดรูปแบบการวางขอ้ความํ การโปรแกรมอ่ืน 
CSS Styles กาหนดการใชส้ไตล ์ํ Cascading Style Sheet 
File Compare กาหนดโปรแกรมท่ีใชเ้ปรียบเทียบไฟลว์าไฟลไ์หนอพัเดทท่ีสุดํ ่  
File Types/Editors กาหนดการํ ใชโ้ปรแกรมเสริม 
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สว่นประกอบ คาํอธิบาย 
Fonts กาหนดํ  Font และชุดตวัอกัษรท่ีใช ้
Highlighting กาหนดสีท่ีใชแ้สดงองคป์ระกอบตางๆ ํ ่  
Invisible Elements กาหนดการแสดงไอคอนองคป์ระกอบตาง ๆ ในหนา้เวบ็ํ ่  
Layout Mode กาหนดรูปแบบเลยเ์อาท์ํ  
New Document กาหนดคาใหก้บหนา้เวบ็ใหมท่ีเราสร้างขึํ ่ ั ่ ้น 
Preview in Browser กาหนดการเรียกใชบ้ราวเซอร์ํ  
Site การอพัโหลดขอ้มูลไปยงัเวบ็เซิร์ฟเวอร์โดยใช ้FTP 
Status Bar ปรับแตงแถบสถานะ่  
Validator กาหนดตวัตรวจสอบความถกูตอ้งของํ รหสัคาํสัง่  

 
 ในท่ีนีจะแนะนาํ้ รายการท่ีสาํคญัจาํเป็นท่ีตอ้งตงัคากอนใช ้ สวนรายการท่ีไ้ ่ ่่ มไดแ้นะนาํเพราะ่

ถึงแมไ้มตงัคาใหม คาท่ีตงัมาเป็นมาตรฐานกใชง้านได้่ ่ ่ ่ ็้ ้  
 General   : ปรับแต่งการทาํงานทัว่ไป 
 ใหเ้ลือกคาเพิมเติมจากท่ีโปรแกรมตงัมาคือ ่ ่ ้ Allow multiple consecutive spaces เพื่อใหส้ามารถ

ใช ้Spacebar เคาะเวน้วรรคไดต้ามท่ีเราตอ้งการ หากไมเลือกจ่ ะเคาะวรรคได ้1 ครังเทานนัสวนตวัเลือ้ ้่ ่ ก 
อ่ืน ๆ เลือกตามท่ีโปรแกรมเลือกมา   สาํหรับ Maximum number of history steps เป็นจาํนวนขนัตอน   ้
ของการยอ้นถอยหลงั สามารถปรับจาํนวนใหมได้่  เพราะยง่ิคา่ มากกยิงเปลืองหนวยความจาํ ็ ่่ RAM ทาํให้
เคร่ืองคอมพิวเตอร์ทาํงานชา้ลงได ้ดงัรูปท่ี 4.7 

 

รูปท่ี 4.7 แสดงการเลือกคาเพิ่ ่มเติมในรายการเคร่ืองมือ  General 
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 Fonts: กาํหนด Font และชดตัวอกัษรทีใ่ชุ้  
 โปรแกรม Macromedia Dreamweaver 8 นนัถูกออกแบบมา ใหใ้ชไ้ดก้บเวบ็เพจทุกภาษา และ้ ั

สามารถท่ีจะเลือกใชฟ้อนต ์ไดต้ามท่ีมีในระบบปฏิบติัการ ซ่ึงโปรแกรม Macromedia Dreamweaver 8    
จะมีวิธีในการเขา้รหสัท่ีเป็นตวัอกัษรแบบมาตรฐานเทานนั คือ ่ ้ (Unicode) ซ่ึงจะทาํใหมี้ความสะดวกสบาย
ยงิขึน ท่ีไมตอ้งติดตงัโปรแกรมเพิมเติมเหมือนกบ่ ่้ ่ ั้ เวอร์ชนักอนท่ีผานมา่ ่    ทงันี้ ้ ในการท่ีจะใชก้บภาษาอะไร ั
ตอ้งมีการกาหนดรหสั ํ (Encoding) ใหก้บโปรแกรมดว้ยเพื่อท่ีจะไดไ้มมีปัญหาั ่ เกดขึนภายหลงัิ ้  

 เน่ืองจากภาษาไทยนนั มีตวัอกัษร ท่ีคอนขา้งจะละเอียดออนมาก จึงทาํใหเ้กดปัญหาบางครัง จะ้ ้่ ่ ิ
อานภาษาไทยไมได ้ดงันนั ่ ่ ้ ก่อนทีจ่ะ ลงมือในการสร้างเวบ็เพจ ดว้ยโปรแกรม Macromedia Dreamweaver 
8 นนัตอ้งมีการกาหนดรหัส ้ ํ (Encoding) เพื่อให้เวบ็เพจนนัสา้ มารถอานและแสดง่ ภาษาไทยได ้อยาง่
แนนอน่    

 การตั้งค่าให้โปรแกรมอ่านภาษาไทยได้ 
 การกาหนดเริมท่ี ํ ่ Font > Font setting = Thai   สวนอ่ืนอาจไมสาํคญั่ ่ มาก สามารถตงัตาม้

มาตรฐานได ้   แตใน ่ Code View ตอ้งเลือก Font ท่ีแสดงไดท้งั้  ภาษาไทย และภาษาองักฤษและตอ้งปรับ 
Size ใหส้ามารถมองเห็นไดช้ดัเจน และ ดงัตวัอยางท่ีเลือกไวคื้อ่  Angsana New Size = 16 pt ดงัรูปท่ี 4.8 

 

รูปท่ี 4.8 แสดงการกาหนด ํ Font ใหแ้สดงภาษาไทย 
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 New Document: กาํหนดค่าให้หน้าเวบ็แสดงภาษาไทยบนบราวเซอร์ได้  

 การกาหนดคาใน ํ ่ New Document ถือวาสาํคญัท่ีสุดในรายการของ ่ Preference เพราะชวยใหเ้่ รา
ไมตอ้งกงวลเร่ืองการตงัคาเอกสารเวบ็ท่ีเปิดใหมอีก โดยเราจะทาํการตงัคาในหนา้นี่ ั ่ ่ ่้ ้ ้  ตอจากการกาหนดคา่ ํ ่
ในหนา้ตาง ่ Font รูปท่ี 4.8 โดยมีการกาหนดเพิมเติมจากคาํ ่่  Default ท่ีโปรแกรมกาหนดมาให้แลว้ สิงท่ีํ ่
กาหนดเพิมเติมคือํ ่    

 - Default encoding:  ประเภทเอกสารตอ้งกาหนดเป็น ํ Thai Windows ซ่ึงจาํทาํใหส้ามารถแสดง
ภาษาไทยในโปรแกรมเวบ็บราวเซอร์ เม่ือตงัคาแลว้้ ่  โดยสามารถตรวจสอบที่ Tag <Meta> จะปรากฏดงัน้ี       
<meta http-equiv="Content-Type" content="text/html; charset=windows-874" /> 

 - Use when opening existing files that don’t specify an encoding: คือกาหนดวาถา้เปิดไฟลเ์กาํ ่ ่
ขึนมาทาํงานให้ใชค้าตวัอกัษรเดิมท่ีเคยระบุไว ้แตหากไฟลเ์กาท่ีเปิดขึนมาไมไดร้ะบุชุดตวัอกัษร้ ้่ ่ ่่  กให้ใช้็
คาท่ีเราตงัไวนี้ ่ ้ ้ (จากท่ีเราระบุใหม่)  ตรงนีจะมีผลให้ทงัไฟลเ์กา และ ไฟลใ์หมใชค้าภาษาไทยตามที่้ ้ ่ ่ ่ เรา
กาหนดํ ไดท้งัหมด้  

 - Unicode Normalization From: โปรแกรม Macromedia Dreamweaver 8 จะมีวิธีในการเขา้รหสัท่ี
เป็นตวัอกัษรแบบมาตรฐานเทานนั คือ ่ ้ (Unicode) ซ่ึงการใชง้านปกติจะใชแ้บบ C ดงัตวัอยาง่  

 สวนรายการอ่ืนไมตอ้งเปล่ียน  เป็นตามมาตรฐานของโปรแกรม่ ่  ดงัรูปท่ี 4.9   
 
 
 

รูปท่ี 4.9 แสดงการกาหนดคาเริมตน้ใหห้นา้เวบ็ใหม ทุกหนา้ํ ่ ่่  
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 การตรวจสอบการตั้งค่า  Encoding  
 เพื่อใหเ้กดความมนัใจิ ่ การกาหนดํ ภาษาไทย  เม่ือเขา้มาในหนา้สร้างเวบ็เพจใหม ให้ตรวจสอบ่

การเขา้รหสัท่ี  Page Properties หนา้นนั้  ๆ กอนเสมอ เน่ืองจากผูส้ร้างสวนใหญจะพบปัญหาเร่ืองไวรัส่ ่ ่  ท่ี
ทาํใหร้หสัท่ีตงัไว ้ถูกไวรัสเขา้ไปแกเป็นรหสัอ่ืน้ ้  ๆ   จึงควรตรวจสอบกอนที่จะพบวาเม่ือสร้างหนา้เวบ็เพจ่ ่
มาจนเสร็จแลว้ไมสามารถแสดงผลภาษาไทยได ้  การตรวจสอบ่ ทาํได ้ดงัน้ี 

1. เลือกคาํสงัท่ีเมนูบา่ ร์ โดยเลือก Modify จากนนัเลือก ้ Page Properties (หรือสามารถเลือกได้
ท่ีปุ่ม Page Properties ท่ีอยบูนพาแนล ่ Properties Inspector)  

2. จากนนัใหเ้ลือกท่ีหมวดของ ้ Title/Encoding  
3. ในชอง ่ Encoding จะตอ้งแสดงในสถานะ   Thai (Windows)  เทานนั่ ้  (หากเป็นอยางอ่ืน่

แสดงวามีการถูกไวรัสรบกวน  หรือลอ๊กไวแ้ลว้่ ใหแ้กไขเร่ืองไวรัสกอน้ ่ ) 
4. จากนนัคลิก ้ OK       ดงัรูปท่ี 4.10 

 

รูปท่ี 4.10  แสดงลาํดบัการตงัคาการใชภ้าษาไทยกอนใชง้านโปรแกรม้ ่ ่  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 คาํส่ัง หรือ ฟังก์ชันต่าง ๆ ของ Macromedia Dreamweaver  
    โปรแกรม Macromedia Dreamweaver เป็น โปรแกรมเขียนเวบ็ ท่ีออกแบบมาเพื่อ ชวยจดัการ่

กบ เวบ็เพจ โดยผูใ้ชไ้มจาํเป็นตอ้งมีความรู้ ั ่  ในภาษา HTML   ซ่ึงเป็นภาษาสาํหรับสร้างเวบ็เพจ โดยตรง 
ดงันนั ้  โปรแกรม Macromedia Dreamweaver  จึงมีฟังกชนั์ ตางๆ มากมายซ่ึงแตละ ่ ่ ฟังกชนั์ กจะ แสดงผล็
ในลกัษณะของ วินโดวส์ (Windows) หรือแถบคาํสัง่   ตวัอยางของ ่ ฟังกชนั์  เชน ่ (Behaviors) เป็นฟังกชนั์
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สําหรับใชใ้นการควบคุม การใชส้คริปตต์างๆ ่  ในการท่ีจะเลือกใชฟั้งกชนั์  ผูใ้ชต้อ้งทาํความเขา้ใจ และ
เรียนรู้วิธีในการควบคุมการทาํงาน ของฟังกชัน์ ตางๆ ให้เขา้ใจเสียกอน ่ ่ วิธีเรียกใช้ฟังกชัน์ ตางๆ ของ่
โปรแกรม Macromedia Dreamweaver ทาํไดด้งัน้ี 

  เลือกคาํสังท่ีเมนูบา่ ร์โดยคลิกเลือกเมนู Window กจะปรากฏ รายการของคาํสั็ ่งควบคุม หรือ
ฟังกชนั์ ตางๆ ใหเ้ลือก่  เป็นกลุม ่ ๆ เรียกวา่ กลุมหนา้ตาง่ ่ พาเนล ดงัรูปท่ี 4.11 

 
 
 

รูปท่ี 4.11  แสดงหนา้ตางเมนู ่ Window สาํหรับเรียกใชฟั้งกชนัตางๆ์ ่  
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 สาํหรับฟังกชนั์  ท่ีเป็นมาตรฐานในการ ทาํงานกบโปรแกรม ั Macromedia Dreamweaver ท่ีมี
การใช ้งานบอยๆ กมีอย ู่ ็ ่ 3 ฟังกชนั์  ไดแ้ก่   

 1. ฟังก์ชัน Insert จะเป็นฟังกชนั์ ท่ีใชส้าํหรับควบคุมเกยวกบวตัถุตางๆ เชน เลเยอร์ี่ ั ่ ่ , รูปภาพ ซ่ึง
แถบเคร่ืองมือนีจะประกอบไปดว้ย ชุดเคร่ืองมือตางๆ คือ ้ ่ Characters, Common, Form, Frames, head, 
Invisible  

 2. ฟังก์ชัน Properties เป็นฟังกชนั์ ลกัษณะตางๆ เชน ใชใ้นการกาหนดค่ ่ ํ ่าของขอ้ความในเวบ็ สี
ของตวัหนงัสือ รูปภาพ ตาราง เป็นตน้  

 3. ฟังก์ชัน Launcher เป็นฟังกชนั์ สําหรับใชใ้นการจดัการหรือควบคุมในสวนของ ่ สคริปต ์
หรือ Behavior ตาง่  ๆ      ดูฟังกชนัตาง ์ ่ ๆ ดงัรูปท่ี 4.12 
   

 
  
 
 

รูปท่ี 4.12  แสดงหนา้ตางคาํสงั หรือ พาเนลกรุ๊ป่ ่ ตางๆ่  
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   5.     ร้จักเคร่ืองมอืของโปรู แกรม 
 
  เม่ือเขา้สูโปรแกรม ่ Dreamweaver 8 ครังแรก้  จะปรากฏกรอบ Workspace Setup ใหค้ลิกเลือก 
Designer แลว้คลิก OK เพื่อเขา้สูหนา้จอการออกแบบของโปรแกรม่  Macromedia Dreamweaver 8 > 
จากนนัจะ้ ปรากฏหนา้จอ Start Page ซ่ึงเป็นเคร่ืองมือสาํหรับเริมต้่ นการทาํงาน โดยตวัเลือกจะแบงเป็น่   3 
กลุม ่   สาํหรับการสร้างเวบ็เพจเปลาแบบพืนฐาน่ ้  ใหเ้ลือกกลุม่  Create New  แลว้คลิกท่ี  HTML  ดงัรูปท่ี  
4.13          
 

รูปท่ี 4.13  แสดงการเปิดโปรแกรม Dreamweaver 8.0 

 
 
 
 
 
 
 
 
 
 
 
 
 
  

รูปท่ี 4.14  แสดงหนา้เอกสารเวบ็ HTML ใหม่  

                จะเขา้สูหนา้ตางโปรแกรมสร้างหนา้เวบ็เพจให่ ่ ม่  ดงัรูปท่ี  4.14  ทนัที   
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 จากรูปท่ี 4.14  สวนประกอบ่ ของเคร่ืองมือโปรแกรม ตามหมายเลขท่ีแสดง  มีดงัน้ี 
1. แถบช่ือเร่ือง  (Title Bar) แสดงช่ือแฟ้มขอ้มูลท่ีกาลงัใชง้านอยูํ  ่ 
2. แถบคาํส่ัง  (Menu Bar) เป็นสวนท่ีเกบคาํสงัตาง ๆ่ ็ ่่  ท่ีใชง้านในโปรแกรม Dreamweaver 8  
3. แถบ Insert Bar เป็นกลุมเคร่ืองมือท่ีใชส้ร้างองคป์ระกอบตาง่ ่  ๆ ในเว็บเพจ ซ่ึง

ประกอบดว้ยชุดเคร่ืองมือ 8 ชุดดว้ยกนั  
4. เอกสารใหม่ทีเ่ปิดขึน้มา 
5. แถบ Document Tool Bar เป็นส่วนท่ีใชใ้นการจดัการกบเวบ็เพจ ั  ขณะนนั้  เชนการเปล่ียน่

มุมมองในการดูหนา้เวบ็เพจ  
6. พืน้ที่ออกแบบ  (Document Window) เป็นสวนท่ีใชส้าํหรับใสเนือหาและจดัองคป์ระกอบ่ ่ ้

ของเวบ็เพจ โดยประกอบดว้ยมุมมองการทาํงาน 3 รูปแบบดว้ยกนคือ ั Design, Code และ 
Code and Design  

7. แถบสถานะ  (Status Bar)  เป็นสวนท่ี่ แสดงสถานะของการใชง้านโปรแกรม  ขณะนนั ้  
8. Properties Inspector  กลุมเคร่ืองมือควบคุมคุณสมบติั ขององคป์ระกอบตาง ๆ่ ่  
9. Panel Group เป็นกลุมของแผงควบคุม่  ท่ีใชแ้ทนคาํสัง่   ชวยเพิ่ ่มความสามารถในการ

จดัการและออกแบบหนา้เวบ็เพจ 
10. จดคลกิเพือ่ปิดุ -เปิด หนา้ตางพาเ่ นล  

 

รายละเอยีดของเคร่ืองมือทีสํ่าคญัต้องรู้  มีดังนี ้
  แถบสถานะ   
 หมายเลข 1  สวนท่ีไวเ้ลือก ่ Tag HTML หรือ แสดงสถานะวาเรากาลงัทาํงานอยท่ีู ่ ํ ่ Tag HTML 
ใด เชนหากเราคลิกเมาส์ท่ีพืนท่ี่ ้  ตาราง กจะแสดง็  Tag Table โดยมีหนา้ตาง่  Properties เป็นสวนของคาํสัง่ ่
ท่ีใชใ้นการกาหนดคุณสมบติัขององคป์ระกอบตาง ๆํ ่  ท่ีเราตอ้งการเปล่ียนแปลงหรือตกแตง่   
 หมายเลข 2  แสดงเคร่ืองมือปรับขนาดของพืนท่ีทาํงาน  สามารถยอขยาย ้ ่ หรือใช ้Handle รูปมือ
คลิกลากไป เปล่ียนตาํแหนงได้่  
 หมายเลข 3  แสดงขนาดการแสดงผลของหนา้ตาง ่ Windows   
 หมายเลข 4  แสดงขนาดความเร็วในการโหลดไฟล ์ โดยใชม้าตรฐานความเร็วในการโหลด ท่ี    
56  K/sec    ดงัรูปท่ี  4.15 

รูปท่ี 4.15  แสดงสวนประกอบแถบสถานะ่  
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   แถบ Insert Bar    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 รูปท่ี 4.16  แสดงเคร่ืองมือใน Insert bar 
    
                 จากรูปท่ี 4.16  แถบ Insert Barประกอบดว้ยเคร่ืองมือ 8 ชุด ตามคาํท่ีปรากฏ ในรูป มีความหมาย
ดงัน้ี   
 Common    แสดงเคร่ืองมือท่ีเรียกใชบ้อย เ่ ชน ตาราง รูปภาพ การสร้างลิงค ์่ เป็นตน้ 
 Layout       แสดงเคร่ืองมือชวยการออกแบบหนา้เวบ็่  
 Form          แสดงเคร่ืองมือท่ีใชส้ร้างแบบสอบถาม และตวัเลือกตางๆ ่  
 Text            แสดงเคร่ืองมือจดั ปรับแตงตวัอกัษร่  
 HTML       แสดงเคร่ืองมือชวยในการเขียน ่ HTML และจดัการรูปแบบ 
 Application    แสดงเคร่ืองมือชวยจดัการระบบเคร่ืองมือ่  และจดัการขอ้มูล 
 Flash Elements    แสดงเคร่ืองมือจดัการกบไฟลแ์ฟลั ช   
                 Favorite         แสดงเคร่ืองมือท่ีใชจ้ดัการบนัทึกงานท่ีใชบ้อยใหส้ามารถเรียกใชไ้ดเ้ร็ว่  
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 มมมองต่าง ๆ ของ ุ Document Windows  
   ในการออกแบบหนา้เวบ็เพจดว้ยโปรแกรม Dreamweaver 8 เราสามารถเลือกรูปแบบหรือ
มุมมองของหนา้ตางเวบ็เพจได ้่ 3 รูปแบบดว้ยกนั ดงัรูปท่ี 4.17 คือ  
 

รูปท่ี 4.17  แสดงมุมมองการทาํงานของโปรแกรมมี 3 รูปแบบ 

 
 
 
   1.  Code ใชแ้สดงหนา้จอออกแบบเป็นภาษา HTML 
 

รูปท่ี 4.18  แสดงมุมมอง Code  

 
 
 
 
 
 
 
 
 
   

  
 2. Spit (Show Code and Design View)   ใชแ้สดงหนา้จอออกแบบเป็นภาษา HTML และ
หนา้จอ ออกแบบจริงพร้อมกนั 
 

รูปท่ี 4.19  แสดงมุมมอง Spit 
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  3. Design    ใชแ้สดงหนา้จอออกแบบเป็นหนา้จอออกแบบ จริง 
 

รูปท่ี 4.20  แสดงมุมมอง Design 

 
 
 
 
 
 
 
 
 

 
 

   6.     การสร้างโฟล์เดอร์ (Folder) และ ไซต์(Site)เกบ็งาน 
 
 การเริมตน้สร้างเวบ็ไซตใ์หมในโปรแกรม ่ ่ Dreamweaver  จะตอ้งเริมตน้จากการ่ สร้างโฟลเดอร์
เกบไฟลข์อ้มูล ็ ของเวบ็ไซตไ์วก้อน ่  โดยควรออกไปที่ My computer  เลือกไดร์ฟ  ทาํการสร้างโฟลเ์ดอร์
เป็นโฟลเ์ดอร์หลกั(Local root)  การตงัช่ือโฟลเ์ดอร์้ ขอแนะนาํให้ใชภ้าษาองักฤษตวัพิมพเ์ลก็ ใชช่ื้อสัน ๆ ้
โดยช่ือตอ้งส่ือใหรู้้วาทาํงานอะไร  ใหใ้คร เชน ่ ่ web_prasit  แลว้ให้สร้างโฟลเ์ดอร์ยอย่ เกบรูปภาพตาง ๆ ็ ่
ซ่ึงอาจมีหลายโฟลเ์ดอร์ยอยขึนอยกูบลกัษณะงา่ ่ ั้ น  และปริมาณงานท่ีจะนาํมาใช ้ เม่ือสร้างโฟลเ์ดอร์หลกั 
และโฟลเ์ดอร์ยอย่ เรียบร้อยแลว้  จึงกลบัเขา้โปรแกรม Dreamweaver   เม่ือเริมสร้างไฟลเ์วบ็เพจใหม่ ่   
โปรแกรมมีหนา้ตาง ่ Pop up ขึนมา้ ใหส้ร้างไซต ์ (ดงัหมายเลข 1  รูปท่ี  4.21) ใหค้ลิกปุ่ม Manage Site เพื่อ
เขา้สู่หนา้ตาง ่ Manage Site (ดงัหมายเลข 2 รูปท่ี 4.21)  ถา้เขา้มาทาํงานเกามีไซตเ์ดิมแลว้ กเลือกช่ือไซตใ์น่ ็
รายการ  แลว้คลิกปุ่ม Done จะเขา้สูการทาํงานไดเ้ลย  ถา้่ สร้างไซตใ์หม คลิกปุ่ม ่ New  จะเขา้สูหนา้ตาง่ ่
สร้างไซตใ์หม  แตหากคลิก ่ ่ Cancle ท่ีหมายเลข 1 จะเขา้หนา้ตางสร้างเวบ็เลย่   เราสามารถสร้างไซตไ์ด ้
โดย ใชเ้มนู  Site ในหนา้ตางออกแบบเวบ็่ กไดเ้ชนกน็ ่ ั    ดูรูปท่ี 4.21             
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รูปท่ี 4.21  แสดงขนัตอนการเริมสร้าง ้ ่ Site 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 การสร้างไซต ์(Site)  ของโปรแกรม Dreamweaver จะเกบ็ท่ีพาเนล File เป็นเคร่ืองมือเสริมการ
ทาํงานใหส้ามารถทาํงาน เช่น การเปิด    บนัทึก หรือสร้างการเช่ือมโยงไฟลข์อ้มูลตาง ๆ่  ในขณะออกแบบ
เป็นไปอยางรวดเร็ว หากไมไดส้ร้างไซตก์ารทาํงาน่ ่  เปิด  บนัทึก หรือสร้างการเช่ือมโยงจะตอ้งเขา้ไปเปิด
โฟลเ์ดอร์เกบงานทุกครัง ทาํใหท้าํงานชา้็ ้  
 ตอไปนีจะเป็นการ่ ้ แสดงขนัตอนการสร้างไซตใ์หม  ดว้ยวิธีใชเ้มนู ้ ่ Site  จากหนา้ตางทาํงาน่
ออกแบบ  เพื่อจะไดเ้ห็นขนัตอนไดท้งัหมด  ้ ้ ซ่ึงการใชค้าํสังสร้างจากเมนู  ่ Site  กบ การคลิกปุ่ม  ั New  
ตามรูปท่ี  4.21  จะเขา้สูหนา้ตางสร้างไซตใ์หมไดเ้ชนเดียวกน   ่ ่ ่ ่ ั ดงันี  ้  
 1.  คลิกคาํสัง ่ Site>New Site >จะปรากฏหนา้ตาง ๆ สร้างไซต์่ ใหม่ มีให้เลือกสร้าง 2 วิธี คือ 
Basic และ   Advanced > ในท่ีนีจะแสดงวิธี แบบ้  Basic กอน่  > ใหค้ลิกเลือก   Basic 

 2.  จะปรากฏกรอบ Site Definition ขึนมา ้  
 3.  ใหพ้ิมพช่ื์อเวบ็ไซตท่ี์ตอ้งการ ดงัตวัอยาง พิมพช่ื์อ ่ e-learning 

 4.  ในชอง  ่ What is the  HTTP address(Url) of your site?  ยงัไมตอ้งใส่ ่   คลิกปุ่ม Next    
      ดงัรูปท่ี  4.22 
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รูปท่ี 4.22  แสดงขนัตอนการสร้าง ้ Site แบบ Basic 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 5. ในหนา้ตางท่ี ่  2 > ท่ีคาํถาม Do you want to work with a server technology…เน่ืองจากเรายงั
ไมไดใ้ช ้่ Server ตามขนัท่ี้  4   จึงใหค้ลิกเลือก No, I do not want to use a server technology แลว้คลิก
ปุ่ม Next  
 6. ในหนา้ตาง  ่ path 3 >How do you to work with your filed during development?  ถาม
เกยวกบการทาํงานกบไฟล์ี่ ั ั  ระหวางดาํเนินการ ่  ซ่ึงตอ้งตอบขอ้แรก คือเราจะทาํงานท่ีเคร่ืองของเราจนเสร็จ
กอนแลว้ ่ Upload ภายหลงั ใหเ้ลือกตอบตามตวัอยาง หมายเลข ่ 6 

 7.  ท่ีหมายเลข 7   Where on your computer do you want to store your files? คือถามวาเราจะเกบ่ ็
งานไวท่ี้ไหนในเคร่ือง  ใหค้ลิกปุ่ม Brown ระบุช่ือไดร์ฟและโฟลเดอร์ท่ีจะใชเ้กบขอ้มู็ ลของเวบ็ไซตซ่ึ์งได้
แนะนาํใหส้ร้างไวก้อนแลว้ ใหค้ลิกเลือก่  Folder ท่ีสร้างไว ้จากนนัคลิกปุ่ม้  Next   ดงัรูปท่ี 4.23 
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รูปท่ี 4.23  แสดงขนัตอนการสร้าง ้ Site แบบ Basic 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 8.  คลิกท่ีชอง ่ How do you connect to your remote server? แลว้คลิกตวัเลือก None จากนนัให้้
คลิกท่ีปุ่ม Next  

 9.  จะแสดงกรอบสรุปรายละเอียดท่ีเรากาหนด   ํ ให้เห็นวาได้กาหนดเว็บไซต์ใหมเป็น่ ํ ่               
ท่ีเรียบร้อยแลว้  

       10.  คลิกท่ีปุ่ม Done เพื่อเริมตน้การออกแบบเวบ็เพจ่  จะปรากฏช่ือของเวบ็ไซต ์พร้อมทงั้
ตาํแหนงท่ีเกบเวบ็ไซต ์แสดงไวใ้น ่ ็ Panel Group    ดงัรูปท่ี 4.24 
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รูปท่ี 4.24  แสดงขนัตอนการสร้าง ้ Site แบบ Basic 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 วิธีสร้าง Site  แบบ Advanced  ใหเ้ลือกรายการ  Local Info  แลว้ตงัช่ือ ้ Site ระบุโฟลเ์ดอร์เกบ็
งาน โดยเง่ือนไขตาง ๆ เชนเดียวกบ แบบ ่ ่ ั Basicเพียงแตเรา่ จะเห็นรายการท่ีตอ้งระบุอยใูนหนา้เดียวกน่ ั  ให้
เลือก  Local Info  >  ตงัช่ือ ้ Site name  > Local root folder โดยการคลิกปุ่ม Browse  เลือก Folder ท่ีสร้าง
เตรียมไวแ้ลว้   > Default  images folder โดยการคลิกปุ่ม Browse  เลือก Sub Folder ช่ือ  images ท่ีสร้างไว้
ใน Local root folder  แลว้ >  ท่ี Links relative to เลือก Document  >  ท่ี HTTP address: ไมระบุ่ เพราะไมมี ่
Url  >  ท่ี  Cache  ใหค้ลิก Enable Cache เพื่อเปิดใชห้นวยความจาํ ่ Cache  จะทาํใหก้ารทาํงานเร็วขึน  ้ >   
เสร็จแลว้คลิก  OK    ซ่ึงจะเห็นวาการสร้าง ่ Site  แบบ Advance สามารถทาํไดร้วดเร็วกวา่แบบ   Basic 
และเราใสขอ้มูลภายในหนา้ตางเดียว่ ่   ดงัรูปท่ี 4.25 
 
 
 
 
 
 
 
 
 



 112 

 

รูปท่ี 4.25  แสดงการสร้าง Site   แบบวิธี Advanced 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
จะปรากฏโฟลเ์ดอร์และไซต ์ท่ีพาเนลไฟล ์บนหนา้ตางออกแบบดา้นขวา่   ตามหมายเลข 3   ดงัรูปท่ี 4.26   
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 4.26  แสดงสร้างในพาเนล File    
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    7.     เร่ิมต้นสร้างเวบ็เพจกบั Dreamweaver 8.0 
 

 โปรแกรม Dreamweaver เป็นโปรแกรม ออกแบบสร้างเวบ็ในแบบ WYSIWYG   คือสามารถ
ใสเนือหา่ ้   รูปภาพไดเ้หมือนการใชโ้ปรแกรม MS Word ออกแบบเอกสาร    โปรแกรมจะสร้างรหสัคาํสัง่    
HTML หรือ Tag  ใหอ้ตัโนมติั  ผูใ้ชไ้มจาํเป็นตอ้งมีความรู้ดา้น่ ภาษา HTML มากนกักสามารถสร้างเวบ็ได้็   
เพียงแตอาจแกปัญหาไดไ้มดี เทาผูท่ี้มีพืนฐานภาษ่ ้ ่ ่ ้ า HTML เพราะการสร้างเวบ็จะตอ้งสามารถดูรหสัคาํสัง่  
เพื่อแกไข  หรือเพิมคาํสังบางอยางลงไปไดด้ว้ย้ ่่ ่     การทาํงานสร้างเอกสารเวบ็แบงได ้ ่ 2  กรณี คือ  กรณี
การสร้างเวบ็ใหม  กบ  กรณี่ ั เปิดเวบ็ท่ีสร้างไวแ้ลว้มาแกไขตอ  ้ ่    ซ่ึงในท่ีนีจะเนน้้ เฉพาะการสร้างไฟลใ์หม   ่
เพราะการเปิดไฟลท่ี์เกบ็ไวม้าทาํงาน   ผูอ้อกแบบเพียงเขา้เมนู File >  Open  กเปิดงานมาทาํงานตอได้็ ่ เลย 
 การเริมตน้สร้างเวบ็เพจดว้ยโปรแกรม ่ Dreamweaver8.0 ตอ้งเขา้ใจลาํดบัการทาํงาน   การกาหนดํ
กรอบพืนท่ีเนือหาให้เป็นระเบียบกอน แลว้จึงดาํเนินการใสเนือหา ตกแตงควา้ ้ ้่ ่ ่ มสวยงามดว้ยภาพกราฟิก 
ใสเทคนิคสร้างความนาสนใจตอไป การจดัเนือหาในเอกสารนีไดจ้ดัเรียงลาํดบัไวต้งัแตขนัเริมตน้่ ่ ่ ่้ ้ ้ ้ ่  ดงัน้ี 
  

1.   สร้างหน้าเวบ็เพจใหม่  
 การ เริมสร้างเวบ็เพจใหม่ ่ทาํได ้  2   วิธีดงัน้ี 
 วิธีท่ี 1  เลือก Design > เลือก Create New คลิกท่ี   HTML จะเขา้สูหนา้ตางโปรแกรม่ ่  เราจะได้
หนา้เอกสารเวบ็สาํหรับออกแบบใหม่   1 หนา้   ดงัรูปท่ี 4.27 
 

รูปท่ี 4.27  แสดงการเปิดสร้างเอกสารเวบ็เพจใหมเม่ือเริมใชโ้ปรแกรม่ ่
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วิธีท่ี 2 ใชว้ิธีสร้างไฟลใ์หมจากเมนูไฟล ์ ่ ทาํไดด้งัน้ี 
 1. คลิกคาํสงั ่ File >   2. New... ท่ีแถบเมนู  
 3. จะปรากฏกรอบ New Document ขึนมา โดยคลิกท่ีตวัเ้ ลือก Basic page ในชอง่  Category  
 4. คลิกตวัเลือก HTML ท่ีชอง ่ Basic page  
 5. คลิกปุ่ม Create         ดงัรูปท่ี 4.28 

  
 

รูปท่ี 4.28  แสดงการเปิดสร้างเอกสารเวบ็เพจใหมเม่ือใชโ้ปรแกรมแลว้่  
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2. การกาํหนดคณสมบัตพิืน้ฐานของุ หน้าเวบ็เพจ  
  การสร้างเวบ็เพจทุกครัง ้  นอกจากตอ้งกาหนดคาพืนฐานแกตวัโปรแกรมในํ ่ ้ ่  Edit Preferences   
และกาหนด ํ Site ในพาเนล File ดงัไดก้ลาว่ มาแลว้   เม่ือจะลงมือออกแบบหนา้เวบ็เพจ จะตอ้งทาํการ
กาหนดคาพืนฐานํ ่ ้  เชน่  ช่ือหนา้เวบ็เพจ (Title) สีพืน ้ (Background color)  สีของขอ้ความ (Text color) เพื่อ
ใชเ้ป็นคาพืนฐานของหนา้เวบ็ การกาหนดคุณสมบติั่ ํ้ พืนฐานหนา้เวบ็ทาํไดจ้ากรายการใน้  Page Properties 
ทาํไดด้งัน้ี 
 เริมท่ี ่ คาํสงั ่ Modify > Page Properties ท่ีหนา้ตาง่  Page Properties มีรายการ 2 สวน คือ่  
 1. Category คือรายการมี 5 รายการ ดงัหมายเลข 1 ใหเ้ลือกตงัคาท่ีจาํเป็นกอน ดงัรูปท่ี้ ่ ่  4.28  
 2. กาหนดลกัษํ ณะการแสดงผลของแตละรายการใน ่ Category   ดงัตวัอยางท่ีนาํมา่ แสดง           
2 ตวัอยาง่  คือ       
 2.1  Appearance 
          Appearance เป็นคุณสมบติัทวัไป ของหนา้เวบ็เพจ่    มีรายละเอียด ดงัรูปท่ี 4.29 
  

                 
 
 
 
 
 
 
 
 
 
 
 
  

รูปท่ี 4.29  แสดงการกาหนดคาํ ่ Appearanceใหห้นา้เวบ็ใหม่ 
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 ความหมายของ ชองรายก่ ารท่ีใหใ้สรายละเอียด่   ใน Appearance มีดงัน้ี 
1. Page font รูปแบบตวัอกัษร  
2. Size ขนาดตวัอกัษร  
3. Text color สีของขอ้ความทวัไป่   
4. Background color สีพืนหลงัของหนา้เวบ็เพจ้   
5. Background image ภาพฉากหลงัของหนา้เวบ็ 

6. Repeat วิธีแสดงภาพฉากหลงัแบบซาํ ๆ้   
7. Left margin ระยะขอบดา้นซา้ยของหนา้เวบ็ 
8. Right margin ระยะขอบดา้นขวาของหนา้เวบ็ 
9. Top margin ระยะขอบดา้นบนของหนา้เวบ็ 

10. Bottom margin ระยะขอบดา้นลางของหนา้เวบ็่   

 2.2   Title/Encoding   
 Title เป็นการกาหนดช่ือหัวเร่ืองหนา้เวบ็ และํ  Encoding Title เป็นการกาหนดภาษาํ                
ท่ีใชข้อง เวบ็เพจ ใหก้าหนดเป็นํ Thai (windows)    เลือกรายการแลว้คลิก OK ดงัรูปท่ี 4.30 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

3.  การใช้ตารางกาํหนดพืน้ทีแ่สดงผลเนือ้หาบนเวบ็ 
 ตาราง (Table) นบัเป็นเคร่ืองมือสาํคญัในการจดัการระเบียบขอ้มูล เพราะการออกแบบเวบ็เพจ
นนัเราจะตอ้งกาหนดตาํแหนงก้ ํ ่ ารแสดงผลขอ้มูล รูปภาพ หรือกราฟิกตาง่  ๆ บนบราวเซอร์   ให้ตรงกบั    
การออกแบบท่ีเราสร้างใหม้ากท่ีสุด การผดิเพียนจากตาํแหนงท่ีออกแบบกบการแสดงผลบนบราวเซอร์จะ้ ่ ั
เกดเสมอ เชนิ ่  ขนาดตวัอกัษรใหญขึน หรือมีชองวางเกดขึน ตาํแหนงบรรทดัเปล่ียนไป่ ่ ่ ิ ่้ ้     ตารางจะเป็น
เคร่ืองมือท่ีดีท่ีสุดท่ีจะชวย่ กาหนดํ ตาํแหนงใหเ้ราได ้ ่   การใสตารางทาํไดด้งัรูปท่ี ่ 4.31 
 1. คลิกตาํแหนงวางตาราง ่ > 2. เลือกรายการคาํสัง ่ Common > 3. เลิกเลือกคาํสังแทรกตาราง  ่ > 
จะปรากฏตารางใหก้าหนดรายละเอียดํ  (ดงัหมายเลข 4 – 8) >  

รูปท่ี 4.30  แสดงการกาหนดหวัเร่ืองใหห้นา้ํ เวบ็ใหม่ 
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  หมายเลข 4. กาหนดจาํนวนแถวํ (Rows)  และจาํนวนคอลมัน์ (Columns)   
  หมายเลข  5. ความกวา้งของตาราง  สามารถเลือกเป็น  Percent หรือ pixels  
  หมายเลข  6. กาหนดความหนาของเสน้ตาราง ํ  
  หมายเลข  7. กาหนดระยะหางของ ํ ่ Objects กบัเสน้ขอบตารางแตละเซลล์่  
  หมายเลข  8. กาหนดระยะระหวางเซลล์ํ ่     >   
  9.  เสร็จแลว้ คลิก OK ดงัรูปท่ี 4.31 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 เม่ือไดต้ารางแลว้เรากสามารถ็ เลือกพืนท่ีตารางแลว้ทาํการ้ ปรับแตงแกไข  ได้่ ้ โดยเม่ือเลือกพืนท่ี้
แลว้คลิกเมาส์ปุ่มขวา  จะปรากฏคาํสงัตามรายการใหเ้ราเลือกใชค้าํสงัได ้ ่ ่ ดงัรูปท่ี  4.32 
 
 
 
 

รูปท่ี 4.31 แสดงการใชค้าํสงัสร้างตาราง่  



 118 

 
 
 
 
 
 
 
 

 
 
 
4.   การใส่ข้อความบนหน้าเวบ็  
 การแทรกขอ้ความในหนา้เวบ็เพจ  ผูอ้อกแบบเพียงแตพิมพข์อ้ความท่ีตอ้งการลงไป่  หรืออาจจะ
คดัลอก (Copy) ขอ้ความท่ีพิมพไ์วเ้รียบร้อยแลว้จากไฟลอ่ื์นมาใชก้ได้็  ทงันีขอแนะนาํให้ใชต้ารางชวย้ ้ ่
กาหนดพืนท่ีเนือหาเหลานนัไว้ํ ่้ ้ ้  จะดีท่ีสุด  
  4.1  การพมิพ์ข

รูปท่ี 4.32 แสดงคาํสงัเพื่อแกไข ปรับแตง่ ้ ่ ตาราง 

้อความในหน้าเวบ็เพจ  
  การพิมพข์อ้ความในหนา้เวบ็เพจสามารถทาํไดง้าย โดยพิมพข์อ้ความท่ีตอ้งการ่  เม่ือตอ้งการขึน้
บรรทดัใหมใหก้ด่  Enter (Tag <P>) หรือกด Shift + Enter (Tag <br>) ในกรณีท่ีตอ้งการใหร้ะยะบรรทดั
ไมหางกนมาก่ ่ ั  
  4.2  การคดัลอกข้อความจากไฟล์อืน่มาไว้ในหน้าเวบ็เพจ 
  เราสามารถคดัลอกขอ้ความท่ีพิมพไ์วด้ว้ยโปรแกรมอ่ืน แลว้นาํมาวางไวใ้นหนา้เวบ็เพจได ้ซ่ึง
สวนมากในการทาํเว็บไซต์่  มกัจะนิยมพิมพข์อ้ความท่ีตอ้งการเตรียมไวโ้ดยใช้โปรแกรม Notepad   
(นามสกลุเป็น txt) หรือ จากไฟล ์Word (.doc) กไดเ้ชนก็ ่ นั  
 4.3  การเว้นวรรคระหว่างข้อความ 
  การใสขอ้ความบนหนา้เวบ็เพจนนั ปกติแลว้โปรแกรม ่ ้ Dreamweaver 8 จะเวน้วรรคให้เพียง     
1 ครังเทานัน้ ้่    แตอยางไรกตามเราสามารถที่จะเวน้วรรคมากกวา่ ่ ็ ่  1 ครังได ้โดย กดแป้นพิมพ์้  
<Ctrl>+<Shift>+<Space> ซ่ึงหากมีการกาหนดท่ี ํ Edit Preferences > General > Allow multiple 
consecutive spaces    ดงักลาวแลว้ในรูปท่ี ่ 4.7 กจะสามารถเคาะ ็ Space bar เพื่อเวน้วรรคไดเ้ลย 
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 4.4  การจัดรปแบบข้อความบนหน้าเวบ็ู   
 การจดัรูปแบบอกัษรในงานออกแบบเวบ็เพจดว้ยโปรแกรม Dreamweaver 8   สามารถทาํได้
ดงันีคือ้     รูปท่ี 4.33 

 1. ระบายขอ้ความท่ีตอ้งการจดัรูปแบบอกัษร  
 2.  กาหนดคาในสวนของพาเนล ํ ่ ่ Properties  

 
 

 
 
 
 
 
 
 
  4.5 การแทรกสัญลกัษณ์พเิศษ 
  สัญลกัษณ์พิเศษท่ีไมมีในแป้นพิมพ ์สามารถจะแทรกเพิมเติมไดจ้ากแถบ ่ ่ Characters โดยทาํได้
ดงันีคือ้     ดงัรูปท่ี 4.34 

รูปท่ี 4.33 แสดงการกาหนดคาใหก้บตวัอกัษรํ ่ ั (Font) 

1. วางเคอร์เซอร์ในตาํแหนงท่ีตอ้งการแทรกสญัลกัษณ์พิเศษ่   
2. คลิกเลือกแถบคาํสงั ่  "Text"  
3. จากนนัคลิกเคร่ืองมือ ้   เลือกสญัลกัษณ์ตามตอ้งการ  

 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 4.34  คาํสงัแทรกสญัลกัษณ์พิเศษ่  
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 4.6  การใส่เส้นคัน่เนือ้หา  
 1. การแทรกเสน้แบงเนือหา่ ้  มีวิธีการดงันีคือ้  

   > เริมจาก่ วางเคอร์เซอร์ในตาํแหนงท่ีตอ้งการแทรกเ่ สน้    > คลิกเลือกแถบ "HTML" บน    

Insert Bar > จากนนัคลิกเคร่ืองมือ้   จะไดเ้สน้คนัเนือหาตามตอ้งการ่ ้  
 2. การปรับแตงสีเสน้่  เม่ือไดเ้สน้มาแลว้ เราสามารถปรับแตงเ่ สน้ได ้ดงัน้ี 
   >  คลิกท่ีเส้นคนัท่ีตอ้งการปรับแตง่ ่   >  กาหนดคาในสวนของพาเนล ํ ่ ่ Properties  ซ่ึง
ประกอบดว้ย 

          W               คือความยาวของเสน้ ซ่ึงจะเลือกกาหนดเป็นแบบพิกเซล หรือ ํ % กได้็   
H                คือความหนาของเสน้ คาปกติจะกาหนดความหนาไว ้่ ํ ท่ี 3 พิกเซล  
Align          คือการจดัวางเสน้ จะเลือกแบบชิดซา้ย กลาง ขวา กได้็   
Shading     คือการกาหนดใหเ้สน้เป็นแบบเสน้ทึบหรือเสน้โปรงํ ่  

 4.7  การบันทกึ (Save) เวบ็เพจ  
  ไฟลเ์วบ็เพจของ Dreamweaver 8 ถา้ยงัไมไดบ้นัทึก ่ (Save) ขอ้มูลท่ีทาํการแกไข้  จะสังเกตได้
จากบนแถบช่ือเร่ือง (Title Bar) จะมีเคร่ืองหมาย * ปรากฏอยทูา้ยช่ือไฟล ์ซ่ึงเป็นเคร่ืองหมายเตือนวายงั่ ่
ไมไดบ้นัทึก ่ (Save) ขอ้มูลของไฟลน์นั ไฟลข์อ้มูลของ ้ Dreamweaver 8 จะถูกจดัเกบใหเ้ป็นไฟลป์ระเภท ็
html ใหอ้ตัโนมติั คาํสงัท่ีใชใ้นการจดัเกบขอ้มูล สามารถเลื่ ็ อกใชต้ามรูปแบบการออกแบบไดด้งันีคือ้   

File>Save…       จดัเกบไฟลโ์ดยใชช่ื้อเดิม็   
File>Save As… จดัเกบไฟลโ์ดยใชช่ื้อใหม็ ่  
File>Save as Template… จดัเกบเป็นไฟลเ์ทมเพลต็   
File>Save to Remote Server จดัเกบไวท่ี้ ็ Remote Server  
File>Save All    จดัเกบทุกไฟล์็ ท่ีเปิดใชง้านอยู ่ 

นอกจากนียงัสามารถใชแ้ป้นพิมพ์้  <Ctrl>+<S> แทนการใชค้าํสัง่  File>Save… หรือ             
File>Save As… ได ้ 
 

 4.8  การเปิด (Open) ขึน้มาแก้ไข  
 เวบ็เพจท่ีไดอ้อกแบบยงัไมเสร็จหรือตอ้งการทาํ่ การแกไขใหม สามารถเปิดเวบ็เพจนนั้ ่ ้  ๆ ขึนมา้
แกไขได้้  ตามขนัตอนดงันี คือ้ ้   

1. เรียกใชง้านในสวนของ ่ Group Panel  ซ่ึงเราไดส้ร้าง  Site  ไวแ้ลว้ จากนนัใหค้ลิกเลือกช่ือ้
ของเวบ็ไซตท่ี์ตอ้งการแกไขขึนมา้ ้   

2. ดบัเบิลคลิกช่ือไฟลป์ระเภท htm หรือ html ท่ีตอ้งการแกไข้   
3. ไฟลท่ี์ตอ้งการแกไขจะปรากฏขึนมา้ ้     

              ดงัรูปท่ี  4.35 
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5.  การดผลการออู กแบบบนบราวเซอร์  
  การออกแบบเว็บเพจไมวาจะ่ ่ ดว้ยโปรแกรม Dreamweaver8.0 หรือโปรแกรมใด ๆ กตาม  ็
ผูอ้อกแบบตอ้งทาํการตรวจสอบการแสดงผลดว้ยโปรแกรมเวบ็บราวเซอร์ (Web Browser) ทุกระยะ         
ท่ีมีการใสเนือหา  รูปภาพ ่ ้  หรือกราฟิกตาง ๆ  เพื่อตรวจสอบผล   ่  เพราะการแสดงผลบางอยางไมสามารถ่ ่
จะแสดงผลในบราวเซอร์ได ้    คาํสังเพื่อ่ ดูผลท่ีเวบ็บราวเซอร์ (Browser)  ของโปรแกรม  Dreamweaver   
ทาํได ้ 3  วีธี  ดงันี  ้ (ทุกครังท่ีสงัดูผลตอ้งบนัทึกไฟลเ์วบ็เพจนนักอน้ ่ ้ ่  ถา้ไมบนัทึกโปรแกรม่ จะเตือนเสมอ) 

 วิธีท่ี   1   ใชค้าํสงั ่ File > Preview in Browser > Explorer  
  วิธีท่ี  2   คลิกท่ีปุ่มหรือไอคอนคาํสงั   ่ Preview in Browser ดงัรูปท่ี 4.36 
 
 
 
 
 
 วธีิท่ี 3  ใหใ้ชค้ลิกท่ีคีย ์ F12   ซ่ึงเป็นวธีิท่ีงายและเร็วท่ีสุด่  

รูปท่ี 4.35  แสดงการเปิดไฟลม์าแกไขจาก ้ Group Panel 

รูปท่ี  4.36  แสดงการใชปุ่้มคาํสง่ั ดูผลบนบราวเซอร์ 
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สรปบทเรียนุ   ในหนวย่ การเรียนท่ี 4   น้ีนักเรียนตอ้งสามารถติดตงัโปรแกรม   ทาํความเขา้้ ใจเคร่ืองมือ
ของโปรแกรม   ทดสอบคาํสังตาง่ ่ ๆ  ตามท่ีไดแ้นะนาํไว ้ โดยเฉพาะการตงัคาเริมตน้ใน ้ ่ ่ Preferences  เร่ือง
การกาหนดํ ภาษา  การแสดงผลเป็น Thai windows  นบัวาสาํคญัตอนกัออกแบบเวบ็ท่ีใชภ้าษาไทยมาก  ่ ่
หากออกแบบไปแลว้มาตงัคาภายหลงัจะมีปัญหามาก้ ่ ท่ีตอ้งแกไข ซ่ึงหากนกัเรียนสามารถแกไขรหสัคาํสัง้ ้ ่
ไดปั้ญหากจะนอ้ย  เชนเร่ืองภาษาไทยกเขา้ไปแกไขที่ ็ ่ ็ ้ Tag META  ในสวน ่ Head เป็นตน้  การเรียนรู้การ
สร้างเวบ็ตามเนือหานี  นกัศึกษาตอ้งทาํการทดสอบปฏิบติั้ ้ ตามคาํสังท่ี่ กล่าวถึงทุกคาํสัง  แลว้ทาํใบงานเพื่อ่
ทดสอบความเขา้ใจ   เม่ือไดท้าํใบงานที่กาหนดได ้ แสดงวาเรามีความเขา้ใจในสวนเนือหานีแลว้  จึงํ ่ ่ ้ ้
เรียนรู้ในหนวยการเรียนตอไปได้่ ่  
 
 

............................................................................................. 
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เพื่อใหน้กัศึกษาทบทวนความรู้ในบทเรียน ใหต้อบคาํถามตอไปนี่ ้   วาเรามีความรู้ในสิงตอไปนีเพียงใด่ ่่ ้  
 

แบบฝึกหัดประจาํบทเรียน 
 

คาํส่ัง   ใหต้อบคาํถามตอไปนี่ ้  
1. บริษทัผูผ้ลิตโปรแกรม Dreamweaver คือ......................................................................................... 
2. โปรแกรม Dreamweaver  กบั  “WYSIWYG” อานวา ่ ่ "วซิซีวกิ"  มีความหมายสมัพนัธ์กนอยางไรั ่  
.... ...................................................................................................................................................... 
3. เม่ือเริมตน้ใชโ้ปรแกรมท่ีติดตงัใหม ตอ้งตงัคาพืนฐานท่ีคาํสงัใด  และตงัคาอะไรบา้ง่ ้ ้ ่ ้่ ่ ่้  
....................................................................................................................................................... 
................................................................................................................................................................. 
4. เพราะเหตูใดกอนลงมือออกแบบสร้างหนา้เวบ็  จึงกาหนดใหต้อ้งเริมสร้าง ่ ํ ่ Folder และ Site กอน่  
................................................................................................................................................................. 
5.    Meta  Tag  :  คาํสงัพิเศษ เพื่อชวยอาํนวยประโยชน์ตอการ่ ่ ่ สร้างเวบ็ใชร้ะบุไวใ้นสวนใดของ่ คาํสั่ง 
HTML ..............................ให้หาตัวอยางคาํสัง ่ ่ Meta มา  4   คาํสัง่ ...............................…… 
................................................................................................................................................................. 
6.  คาํสง่ัเรียกใชต้ารางใน Dreamweaver มีก่ีวิธีอะไรบา้ง……………………………………………… 
………………………………………………………………………………………………………… 
7.  การกาหนดชนิดํ  แบบ ตวัอกัษร มีขนัตอนการกาหนดอยางไร้ ํ ่ ……………………………………... 

  ………………………………………………………………………………………………………… 
8.  การซ่อนเสน้ตารางมิใหแ้สดงผลบนบราวเซอร์ทาํอยางไร่  ………………………………………… 
…………………………………………………………………………………………………............. 
9.  ตอ้งการกาหนดพืนท่ีเนือหา กวา้ง ํ ้ ้ 800 พิกเซล เม่ือแสดงผลใหอ้ยกูงกลางหนา้จอเสมอ่ ึ่ ตอ้ง ปฏิบติั
อยางไร่ ................................................................................................................................. 
…………………………………………………………………………………………………………. 

10. หากมีการแกไขหนา้เวบ็  แลว้สงัแสดงผลดว้ยการกดปุ่ ม ้ ่  F12 ทนัทีจะเกดเหตุการณ์อะไรขึนเสมอิ ้  
และตอ้งแกไข้ อยางไร่ ………………………………………………………………………………...... 
…………………………………………………………………………………………………………. 
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อ้างองิ 
 
 

กตติ  ภกัดีวฒันะกลุิ ,  Dream weaver MX 2004,กรุงเทพ , เคทีพ ี
เกรียงศกัดิ  เจริญวงศศ์กัดิÍ Í ,ออกแบบและสร้างเวบ็สวยด้วย Dream weaver CS3,กรุงเทพ ; 
             ซีเอด็ยเูคชนั,2551. 

  สร้างโฮมเพจด้วยตนเองกฤษณะ  สถิต ,   ,กรุงเทพ:Info press. 
ประภาพร ชางไม้่ , สร้างเวบ็สวยด้วย Dreamweaver 8.0 , กรุงเทพฯ : ดีจิอาร์ต. 
  การสร้างเวบ็ไซต์ พรเศก จิตตแ์จง้ , ,กรุงเทพ ; Success Media. 
 
 แหลงสืบคน้่ : 
 http://www.macromedia.com/.../dreamweaver/ ) 
 http://www.nectect.or.th
  http://www.webthaidd.com/dreamweaver/news.php?id=445 
 http://cannot.info/page?p=1310520034773 
 http://www.pyayam.com/article/show.php?Category=webpage&No=67
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.nectect.or.th/
http://www.pyayam.com/article/show.php?Category=webpage&No=67
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